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Preface

Document Structure

Table llist the sections in this document with a brief description of each section.

Table 1. AETG System Users Guide Sections (Sheet 1 of 2)

Section
Number Section Name Description
Section 1 | Introduction This section contains general information on

this guide including an overview of some basic
AETG functionalities.

Section 2 | A Quick Tour of the AET{This section details several basic tasks that will

System help you become familar with the AETG
System.
Section 3 | AETG Basics This section contains basic information on

using the AETG GUI.

Section 4 | Using AETG Obijects This section contains information on how tp
use AETG objects

Section 5 | Using the Database This section contains information on the AETG
Browser Database Browser.
Section 6 | Format Object This section contains information on Format

objects, which describe a testable interface to
an application or a testing situation.

Section 7 | Field Object This section contains information on Field
objects, which define the data values that are
input to an application.

Section 8 | Compound Obiject This section contains information on
Compound objects, which let you collect
several Fields and treat them as one Field

Section 9 | Test Object This section contains information on Test
objects, which define the means by which a
requirement is verified in a software
application.

This section also contains information on How
to generate a Test Case Matrix.

Section 10| Relation Object This section contains information on Relation

objects, which let you collect requirements data
to establish how fields and values on the format
relate to one another.
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Table 1. AETG System Users Guide Sections (Sheet 2 of 2)
Section
Number Section Name Description

Section 11| Command Lineobls This section contains information on the AE
Command Line tools.

Section 12| Input Modeling with the | This section provides tips on how the AET

AETG System System could be used to model various typg
applications.
NOTE — The following sections contain information
required by the AETG Adminstrator.
Section 13| Installing the AETG SystEThis section contains information on
installation, including required third-party
software.
Section 14| Configuring the AETG | This section contains information on
System configuring a working installation.

Section 15| Operality Management—-This section describes the procedures use
Starting and Stopping start, stop, and get status of all of the AET
AETG Processes processes.

Section 16| Administrative CLUI This section describes the tasks used to
Commands administeithe AETG System.

Section 17| Person Object This section describes the tasks used to
administer Person objects.

Appendix A Using the AETG System| This section contains information on the

with the MYNAH System | differences in the GUI when the AETG System
is licensed with the MYNAH System.

Appendix § Geneate Tcl Scripts for | This section contains information on

AETG Testcases generating test code when the AETG Syste
licensed with the MYNAH System.

Appendix ¢ Example Installation FilegThis appendix contains examples of the
delivered files used to install the AETG
System.
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Formatting Conventions

The following formatting conventions are used in this document.

e Substitutable or user supplied items (e.g., option and argument values) appear in
boldltalics Times

» File and directory names appeaitalics Times

» Thefirsttime atermis used, it will appeabiold 11-point Helvetica , such as when
we first mentionFormat object.

e Menu names and items will appeatisid 10-point Helvetica , such as when we
mention theEdit menu.

e Cascading menus will appeardold Helvetica with arrows between the menu
options to signify the cascades, such as

Aetg->New->Format

Preface-3
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1. Introduction
This document describes the procedures for using the Automatic Efficient Testcase
Generator (AETG") System.

Software testing is expensive in both time and material resources. By various estimates,
testing can cost as much as 20% to 33% of the total development budget of a software
project. The AETG System can greatly reduce the cost of testing by reducing time to
develop test plans and by reducing the number of maintained test cases. The Bellcore
proprietary combinatorial algorithm generates an efficient set of test cases and these test
cases provide a high degree of coverage for the application under test. The generated output
can be easily introducedto application testing tools to populate screens and/or messages
with data for test automation.

1.1 AETG System Overview
The AETG System runs on the Sola¥iplatform (Release 2.5.1) with any X-windoWs
manager.
Using the AETG System entails performing the following steps:
1. Defining the Interface
2. Defining and Associating Tests
3. Defining the Rules of the Interface
4. Generating the Efficient Set of Test Cases
5. Automating the Test Cases.

The following subsections provide general information each of these tasks.

1.1.1 Starting the AETG System

To start the AETG System, simply type
xmyRunAetg
in a standard UNIX window.

NOTE — The AETG System automatically runs in the
background.

1-1
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1.1.2 Defining the Interface

An interface is the means by which you interact with an application or testing situation,
such as a screen or a communications protocol. You define an interface into which data is
input to an application using an AETG database object cakextraat object. A Format

object is a collection dfield objects, which are database objects that are used to hold
information about the data to be applied to an application. You must define one or more
Field objects from within the Format and then assign one or more Values to each Field.

A completed Format object, therefore, represents an interface to a System Under Test
(SUT) that you wish to validate, i.e., test.

SeeSection 6for information on working with Format objects. Sgection 7for
information on working with Field objects.

Figure 1-lillustratesthe flow of steps you follow to define an interface and how Formats,
Fields and Values are related to each other.

Desktoq |
or

Field
Format

1. From the Desktop (or a Folder), you create one or more Format objeqts.

2. From a Format object, create the Fields that make up that Format.

3. For each Field, define one or more values.

Figure 1-1. Defining the Interface

After you have created more than one Field objects, you can optionally create a
Compound object, which is a databasbject that lets you collect simple Fields into one
set and then treat that set of Fields as a single Field.

Once you have created a Compound object, you must create at ledaptsmewhich is a
reference name given to the specific value set of a Compound.

SeeSection 8for information on working with Compound objects and Tuples.
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1.1.3 Defining and Associating Tests

A Test object is a database object that is used to track and verify compliance with specific
system requirements. Test objects are created witshHierarchies , which are
equivalent to directories (or folders).

SeeSection 9or information on working with Test objects.

You may need one or more Test objects to test all the things you want to verify about a
Format, such as in the following scenarios:

* You may wish to exercise all the Fields and all combinations of Fields in a Format.

» You may wish to test certain invalid Field values to see how the System Under Test
behaves when given invalid input.

* You can test a subset of the Format’s Fields with one Test object and the remaining
Fields with a different Test object.

* You can test the entire Format with one Test object.

Once you've created a Format object and the desired Test objects, yassuasate the
Format object with each Test object that will validate some aspect of the Format, creating
a link between the Format object and the pertinent Test objects.

Figure 1-2depicts a Format object being associated with multiple Test objects.

Test
1 Object

Format Test
Object Object

Test
Object

1. Associate a Format object with one or more Test objects. These Test objects
describe how the SUT interface that the Format describes will be tested.

Figure 1-2. Associating a Format with Tests

1.14 Defining the Rules of the Interface

After you define the testing interface and define and associate tests, yolr&laéitms ,
which are database objects that define the rules governing the data (i.e., formal
requirements) that will be input to the System Under Test.
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You create one or more Relation objects from within a Test object and define, for each one,
one or more rules, such as “When Field1 has a valbtuef Field2 may not b@ink or
yellow.” The Relation uses a set of Fields from a Format.

Figure 1-2depicts the flow of steps you follow when associating Relation objects with Test
objects.

1
Test
> > :
Object Relation
Format Object
Object
Test 1

Object Relation

Object

1. From a Test object, you create one or more Relations, using some or all of the
information in the Format object. The Relation objects specify rules about
combining Field values.

Figure 1-3. Defining the Rules

Using a Relation object, you can

» Specify which values must be included in the test case. This does not mean these are
the only values that will be included, but that priority will be given that these values
are included.

» Specify which values are to be excluded.

e Specify a set of invalid values to do error dition testing.

1.15 Generating the Efficient Set of Test Cases

When you have finished specifying all the rules that will be used for this Test, you can then
ask the AETG System to generate the efficient set of test cases for this Test. This operation
is performed from the Test object, and theiltdsy Test Gse Matrix is stored with the Test
object.
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Figure 1-4depicts the flow of steps you follow to generate the Test Case Matrix.

Test
Object

- Test Case
Relation Matrix

Object

From a Test object, you ask the AETG System to Generate the Test Case Matrix, using
the information in the Relations that are associated with that Test. Ttnix Ma
comprised of all of the test cases that are needed to exercise the rules in the sét of
Relations.

Figure 1-4. Generating the Test Cases

1.1.6 Automating the Test Cases

The generated Test Case Matrix can potentially be read by an automated testing tool, such
as the MYNAH System, to create a script to automate test cases.

1.1.7 Summary

1. Defining the Interface
A. Create a Format object.
B. Define one or more Field objects.
C. Assign one or more Values to each Field.
2. Defining and Associating Tests
A. Create one or more Test objects that will be used to exercise the interface.
B. Associate these Tests with the Format.
3. Defining the Rules of the Interface

Create one or more Relation objects from within a Test object and define, for each one,
one or more rules.

4. Generating the Efficient Set of Test Cases
Generate a Test Case Matrix using the defined Relation(s).
5. Automating the Test Cases

Figure 1-5contains a flow chart describing the recommended of the steps required to create
a test case.
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Create a Format
Object

Y

Create Field
Objects and
Values

Do you want
to create
Compounds?

Create a Test

Y

Create a Test
Object

Y

Associate a
Format Object
with a Test Object

Y

Create a
Relation Object

Y

Generate a Test
Case Matrix

Create Compound

Objects and
Tuples

Hierarchy <

Figure 1-5. Recommended Steps for Creating a Test Case
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1.2 Command Line User Interface (CLUI)
The Command Line User Interface (CLUI) is a set of commands you can use to perform
AETG utility operations from the UNIX command line.

SeeSection 11for descriptions of the CLUI commands.

1.3 Some Basic Terms we Use

Before we proceed, let us define a few terms and concepts we will use in this document.

1.3.1 Mouse Terms

When referring to how to use a mouse (when working with the AETG GUI), we use the
following terms:

Click This means that you should place the mouse pointer on an item we
identify in an AETG window and press down and release the left mouse
button quickly.

Double click  This means to press down and release the left it twice in rapid
succession.

Pointer This refers to the arrow that indicates the mouse position.

1.3.2 Cascading Menus

Many AETG menu items contain a triangle that iadés that there is a submenu associated
with that menu item, such as the oné&igure 1-6

ﬁirﬂiﬁtlmﬂid Edit iew Toods YWindews

Save Cirle S 5
e Folder
| amity Al Windows Formal
Exit Persan
= Test Hierarcky

Figure 1-6. Cascading Menu Example

1-7
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For example, to access the function depictedidnire 1-6 we would tell you to execute
Aetg->New->Folder
This means you would
1. Click on theAetg menu.
2. Click on theNew menu option.

3. Click on theFolder menu option.

14 On-line Documentation

This document is available on-line in the Ad&b&crobat® PDF format. The PDF file is
accessible from either the local file system or from an internal URL. See the AETG
administator for the location of the PDF file.

Viewing the PDF file requires that you have installed the Adobe Acrobat Réader
(Release 3.0). If you need the Acrobat Reader, contact the AETG administrator. In
addition, you can download the Acrobat Reader directly (off the Internet) from Adobe at
www.adobe.commFollow the instructions detailed on the web page.

Once you have installed the Acrobat Reader, you can read the file

» Using the Acrobat Reader directly if the AETG System has been installed on a local
system.

e Using the Acrobat Reader as plug-in to a browser if the AETG System has not been
installed on a local system, such as if the system has been installed on a UNIX Solaris
server and you are using an X-windows emulator to access the system on a PC.
Consult your browser’s documentation for information on how to install plug-ins.

If you access the PDF file via a browser, you may wish to download the file to your local
system, which will give you direct access to the file the next time you need to read the file,
rather than waiting for the browser to load it.

1.5 Customer Support

You can get support for theEX G System from the MYNAH Customer Service Center
between 8:00 AM and 7:00 PM ET Monday through Friday by calling (732) 699-2668,
Option 3; if outside the 732 area, call (800) 795-3119, Option 3.

During non-standard support hours and holidays, critical problem coverage is provided.

You can also contact support (for non critical problems) via e-mail at
mynah-support@cc.bellcore.com
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2. A Quick Tour of the AETG System

Before we explain the AETG system in detail we want you to perform some simple tasks
that will let you become familiar with how to use the AETG System and what it can do for
you. This section provides a Quick Start, touching on the basic features of the AETG
System.

NOTE — This section does not touch on all of the
features of the AETG System nor provide detailed
information on the features we do discuss.

In this Quick Tour, you will

Create a folder on the AETG desktop to contain the AETG objects.

Create a Format object and the required Field objects to define the interface.
Create a Test Hierarchy and Test object.

Create a Relation object to test alkpible combinations of the Fields you ate

ok~ 0N

Generate the Test Case Matrix, which is the the list of the generated efficient set of test
cases.

Change how the Fields interact with each other.
Regenerate the Test Case Matrix.

Specify fields to be excluded from a test case.

© ® N o

Regenerate the Test Case Matrix.
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2.1  Define what you want to Test

Before you create the AETG obijects, you first have to define what you are using the AETG
System to test (or model) and the rules of the test.

211 Define the Interface

This Quick Tour example uses the AETG System to model a very basic display, defining
the shape, color, and “attributes” of a display elemeaile 2-1lists the display elements

and the possible valuéar each element. Each element is defined using a Field object.

Table 2-1. Quick Tour Elements and Values

Element Field Name Possible Values

Shape e Circle

e Sguare
Color * Red

* Blue

* Yellow
Attribute  Blinking

* Non-blinking

2.1.2 Define the Rules of the Test

For the Quick Tour, you will use the AETG System to generate
1. All possible permutations.

2. All permutations excluding Yellow Squares.
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2.2  Startthe AETG System

Start the AETG System by typing
xmyRunAetg

in a standard UNIX window.

NOTE — Before you start the AETG System, your path
must be set properly to conté@iXxMYDIR/bin Also, your
XMYHOME environment variable must be set. If you
need to, call your AETG administratfmr more
information about doing this.

2.3 Regqistering as an AETG User
The first time you start the AETG System as a new user, the system displays a New User

dialog (Figure 2-). This dialog prompts you for basic information about yourself that the
system will store in its database.

= AETG Welcome Mew User
Lax] rlrmrl
l'lr-ertrrl HI:I_
-
I'I-rnl:!
ok | Est |

Figure 2-1. New User Dialog

The system is case-insensitive to information you dreeg; you can type information in
upper case, lower case, or combination of upper and lower case.

To enter information
1. Type in your last name in thast Name field.

2. Position the pointer in thdrst Name field (you canTab over to it or point and click
with the mouse) and type in your first name.

Position the pointer in thdl field and type in your middle initial.
Position the pointer in tHemail field and type in your e-mail address.

Position the pointer in thehone field and type in your business phone number.

o 0k~ w

Use the mouse to click ti@K button in the bottom, left-hand corner of the dialog.
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You are now registered with your local system as an AETG user.

The system displays the AETG Desktépolre 2-9. This is the first of many AETG
System windows and dialog boxes. We will describe the AETG Deski®pdinon 3

| Deeskaap-List [=]=
#| ety Selected Edn Wiew Tools Windows Heip
¥ B Tl ) ]

L

Figure 2-2. MYNAH Desktop

2-4
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2.4 Create a Folder

The AETG System lets you organize your work into items c&ltdders , which are the
equivalent of UNIX directories or paper folders in which you place a number of documents.

To create a folder
1. Execute

Aetg->New->Folder

A dialog box Figure 2-3 appears requesting a name for the folder.

—‘| AETE Aeguesting sfarmatinon
Folder Mame:
[Crurich Deme
] 4 ] Canael

Figure 2-3. Naming a Folder

2. Position the pointer in tHeolder Name text area and type in a name for it, for
example Quick Demao

3. Click onOK.
The system creates a new folder and places it in the desktop display as a line item. (See
Figure 2-4)
= Desktep-List =]

#| ety Selected [ View Tooks Windows
o T (B @

b guul-uk Demo L EREE TR Feaddier

Figure 2-4. New Folder on the AETG Desktop
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4. Open the Folder by double clicking on the Fokleon. An empty Folder appears.
(SeeFigure 2-5)

=] Falder<Qubck Demss-Ligl [=]=
-'.-'.-'lEtlIdEr Selected Edil View Tools Windows eip

o T (8 M| B il

Figure 2-5. An Empty new Folder

2.5 Create a Format Object

A Format object lets you
» Document the interface you want to represent.
» Define all of the Fields on the Format.
To create a Format object
1. Execute
Folder->New->Format

A new untitled Format object item appears in the Folder. {(Sgee 2-6)

=] Falder<Qubck Demss-Ligl [=]=
-'.-'.-'lEtlIdEr Selected Edil Wiew Tools Windows

o ||/ o] @)ool

I |Untitied - Format -— ol Ay F sl

Figure 2-6. A new Untitled Format Object
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2. Open the Format object by double clicking on the Format object icon. By default, the
system displays the Format object’s Properties view. (8reae 2-7)

= Formal cUsSHed Framsd 1} Praprifies |=]=
ﬂ-‘-‘lFum.ll Selected Edit Wiew Teols YWisdoes Helg
S v W W © b o] &
Maime! | Version: 1
Owmier: (ks Typia:
Descriplion: 5

By [lata Tima

Defsult Yiew: Properties

Figure 2-7. Format Object Properties View

3. Click on theLock icon (in the upper, right-hand corner of the view) to “Unlock” the
Format object.

NOTE — SeeTable 3-1in Section 3.1.4or a list of the
icons in the AETG Tool Bar.

4. The AETG Format Name Dialo§igure 2-§ appears. Enter a name for the Format
object, for exampleDisplay Formatand click onOK.

i AETG Aegeesting isfarmation

Please enier Format mame-
|1:II|pIm.' I armall

QK _Lansel |

Figure 2-8. AETG Format Name Dialog
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5. Optionally, you can

» Select the Format type by clicking on thgre menu and selecting the type of
interface the Format is, for examphesyncScreen .

» Enter a description of the Format object.

The Format object Properties view will look similar to the onEiijure 2-9

= Fumal cTHaplmy Farmal 120405 Fropertics [=]=
.".-'-'lEan Selected Edit Wiew Teols Windoes Helg
8 | 8T Wl o] &l
1504
Hame: | Displey Formast Wersion: 1
Crner: | Wah T¥ie  fmymeSoreen — |

Dweacription: [This Format ebject is seed 1o medel @ display slomentfsith e |
Tollowing eharasberisties: Shape (Circle or Square], Calor [Hed,
Ewie. or Yellow), and Attribute (Eenking or Monbinkmg)l

By Mt Tim
Craatid: | kil 1497 932
Aewaed: | kik (L] 497 93224
Drefault View: Properties

|IZIZJ

Figure 2-9. Completed Format Object Properties View

6. Proceed t&ection 2.0 create the required Field objects and associated Values.

NOTE — SeeSection 6for detailed information on
Format objects.
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2.6 Create Field Objects and Values
A Field object lets you enter information about the Fields on a Format, such as the names
of the Fields and a list of valid values for the Fields.
Creating a Field object is a two step process.
1. You first create a Field object from a Format object’s Fields view.
2. You then specify possible values the Field object.

You will create the Field object and values for 8teapedisplay element listed in the first
row of Table 2-1

To create th&haperield object

1. On the unlocked Format object you createddntion 2.5display the Format object
Fields view. You can do this in one of two ways:

 Click on theFld button on the Format object Tool Bar.
* Execute
View->Change View->Fields

The Fields viewigure 2-1() appears.

= Formal-<isplay Faemat 111 6083-Finlds
2| Format Selected Edit Wiew Tools Windows

S « (&) WS e e o)

CHS

15k

Fllts: . | Mmg Lo el Pl

Compounds: | pame

I |:-:'J

Figure 2-10. Format Object Fields View
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2. Execute

Format->New->Field
An untitled Field row, markeenew field> , appears in thEields list on the Format
object, and a new unlocked Field object appears.

= Fomat-<Diapluy Farmal.1:1504:-Felds ==
ﬁTlEnn‘H Selected Edit Yiew Toods Eindows Help
5 « RGN 6| o]
1503
T Field-<Untifles Field—-Values IEE
-Hr'lﬁhld Edit Wiew Toods \Windews Hidg
o | |8 ) v @ | v ool a
Format Mame Veralon: (Haplay Formal ) ;
Com 3
Mo | | oigeal Haini:
Seq. Mo.: Parameters: |
Walid Values
Cant; 0
S L iPe
= |~
Walle: | Type: lberal ]

Figure 2-11. Creating a New Field Object
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3. Enter, at the minimum, a name for the Field object imtiree text area, for example,
Shape

NOTE — You can not include embedded spaces in a
Field object name. However, you can include embedded

spaces in a name you enter inttlogical Name text area,
for example Element Shape

The edited Field object will be similar to the one-inure 2-12

Field-cUnlilled Fiehl:— - ¥alues ==
a | Eletd Edit View Tsols Windows

o | | 8 Bl v @ Il vt oo

Format H-I.:.'-'Er:-mn:l}.ll.pllyl-urrrlﬂj s
Hame: [Shape Logical Mame; | Element Shape
Zeq. Mo PJrunEmrer
Walld Valses
Cosmnt: 0
L L Type J
0
= -

Walue: Typee: lteral |

Figure 2-12. Entering a Name for a Field Object
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4. Execute

Field->New Value

An untited Value row, markednew-value> , appears in thealid Values list on the
Field object. In additionsnew-value> appears in thgalue text area and is
highlighted, signifying that it is selected and ya@an type over this entry.

= Field-cUnlilicd Fiell:— > ¥alues |=]=
a | Eletd Edit View Tsols Windows lietp
| BIE[® v [© W m) &
Format Mame. ¥ersion:Displey Format.] —

Hame: | Shaps Logical Mamu: |I:E-m-|:nt5h|i:-|;

Zeq. Mo Parameters: |

alld Values

Comnt: 1
Walue | Type |

Walue: !m Type: literal ¢

Figure 2-13. Creating a New Value

NOTE — You can also create a new Values by executing
Ctrl+N (pressing and holding tl@ontrol key and then the
N key) or by clicking on th& button on the Tool Bar.
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5. Enter the first value in thealue text area, for exampl€ircle, and press either the
Return or Tab key. (See-igure 2-14) The system accepts the value and enters it in
theValid Values list.

= Field-cUntiled Field: - Valucs
a | Eletd Edit View Tsols Windows

[=l=
lielp
ERvedan  Tdl
Format Mame ¥ersion:Display Format. 1 —
Hame: | Shaps Logical Mamu: |i:-b:-m_|:nt_5h|;:-|:
Zeq. Mo Parameters: |
Walld Valses
Cosint: 1
Value | T |
= ]
walue: | Circld Type: literal

Figure 2-14. Entering a New Value
6. Execute

Field->New Value
to create a new Value row for the second Value.

7. Enter the second Value for exam@guare and press thReturn key.
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8. To save the Value object, execute

Field->Save

Figure 2-15shows the completed Field object.

=] Formal-<0esplay Fermed 1:1 L0857 lelds BE
A Formal Selected [t iew Tools Windews Help
S o | (6Bl & o el
1504
Firlds: | g,
1 Element Shape | |
= Field-cGhape-1511 - Values B
I.'-l'r'l Field Fdr View Tooks Windews Help
I¥ B[ W v S/6 vl )
Forma Hame Version: Display Fermal.] 101
Hame: |ﬁ1r.q:a' 3 Logioal Hame: [Elemem Shape
Saq Ma 1 Paramsiters:
Walid Wahies
Counk: 3
aluse | Type
Cirche | Bteral |2
Square fiteral
- T
Walse | Typeei |

Figure 2-15. Completed Shape Field Object

9. To close the Value object, execute

Field->Close
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10. Repeat Stepdsthrough9 to create th€olor andAttribute Fields listed inTable 2-1
The completed Format object Fields view will be similar to the oédnre 2-16

= Feernat-<Dinpley Furmal 1215043 Ficlds [=]=
.".-'-'lEnmn Selected Edit Wiew Teols Windoes Helg
8 [T W] o
1504
Fields: | Seq | Mame | Legload Mame | Compund |
1 EEH_I Elimaerd Shape
2 Caolor Clemem Cobor

Compounds: | pame

Figure 2-16. Completed Format Object Fields View

11. To save the Format object, execute

Format->Save

12. Proceed t&ection 2. 4o create a Test Hierarchy and Test object for the test case.

NOTE — SeeSection 7or detailed information on Field
objects.
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2.7 Create a Test Hierarchy and Test Object
Test objects define the requirements used to verify or test adtofiest objects always
appear in their owiiest Hierarchies , which are the equivalent of Folders.
To create a Test Hierarchy and Test object
1. In theQuick Demdolder, execute
Folder->New->Test Hierarchy

A new untitled Test Hierarchy item appears in the Folder. (Seee 2-17)

=| Falder-<Quick Demas-Lisi [=]=
-'.-'-'lEtlIdEr Selected Edil Wiew Tools Windows JL10-]
o | Tl (] W o] @ et o]

I |Untitied - TestHier -~ LR BRI TestHiir

| Désplay Format.i BT 081 A7 Farmat

Figure 2-17. A New Untitled Test Hierarchy

2. Openthe Test Hierarchy by double clicking on the Tesgiri@y icon. An empty Test
Hierarchy Figure 2-19 appears.

e | Teestiimr-cUntitied- Treitfior:—2-List
ﬁ!-'lHInrH-!h'.' Selecied ESr View Tools Wandows

o W RO

Figure 2-18. An Empty Test Hierarchy
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3. Unlock the Test Hierarchy. Rest Hierarchy Name dialog appears~(gure 2-19,
prompting you to enter a name for the Test Hierarchy, for exasplay Test

Hierarchy.
i AFTY Meguenting isfarmatinn
Test Hiermrebry Blame:
|ﬂ|lp|m.' Tiest izrarchy
aK Canael |
Figure 2-19. AETG Test Hierarchy Name Dialog

4. Click onOK.
5. Execute

Hierarchy->New Test
A new untitled Test object(gure 2-2() appears in the Hierarchy.

al TeatHirr <Dizplay Test Hinrarchy- 1501 3Lt
|".-'.-'|H|nrmh'|' | Selpeted Ed wiew Tools Vindows Heips
o |0 © ] e ] _
1501

=1

k gurﬂlud-hll 1500 Test Case LOEE 149:57 44 1

Figure 2-20. A New Test Object
6. Execute
Hierarchy->Save

NOTE — You must save a Test Hierarchy before you can
edit a Test object.
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7. Double click on the untitled Test object icon. The Test object opens, displaying the
Test object Properties view. (Segure 2-21)

= Teet-cUntitied Teui: 15023 Pregerties [=]=
v | Test Sesected Edit View Teols Wilndows Hetg
S+ W@ B oM o mn &)
Poth-Displey Test Hierseshy: 1502
e [ksh
i ||

Type:
[esariphan: 1y
i
Parent Type:
S [T 1E
| iy Date | Time
Created: | ksk |mmnsmr | 1zasza |
Aesdsed: | ksh | ‘ORASNG 1752

Diefault Wiew: Properies

Figure 2-21. Test Object Properties View
8. Unlock the Test object.
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9. Enter, at a minimum, a name for the Test ahjor exampleDisplay Test
Figure 2-22shows an edited Properties view, including a dptonifor the Test
object.

—I Teel-llinpley 'lll:l%rﬁ-
ﬁVlTEﬂ Seleeted Edit View Teols ¥Wiisdoes

|=]=
g
9 o | /B © Wmw fuu] =
Pagh: Displey Test Hierarchy: 1502
Cewnier:| ksh
M| Daspiey Test
Yersisn: 1
TYPE: feat Case |
Dresaription: [This Test object uses i Format ohjecl. Cieplay LY
Formatl, te ergate the desioed Test ¢agis,
i
Parent Type
W Stafused
- Hikis
| iy Date | Time
Created: | ksb RHT S R b
Aesdsed: | ksh oRZ 1N 133550
Diefault Wiew: Properies

Figure 2-22. Edited Test Object Properties View

10. Proceed t&ection 2.8&0 associate the Test object with Display Format-ormat
object.

NOTE — SeeSection Yor detailed information on Test
Hierarchies and objects.
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2.8 Create an Association

To create a test case, you must fassociate a Format object with a Test object, which
creates a link between the Format object and the Test object. Associating a Format object
with a Test object lets the Test object know what Fields and Values are available for the test
case.

NOTE — A Test object can only be associated with one
Format object at a time. However, a Format object can be
associated with more than one Test object at a time.

You will
1. Use the AETG Database Browser to display the Format objects defined in the AETG
database.

NOTE — The AETG System Database Browser provides
a quick and easy way of locating objects in the AETG
Database. Se®ection Sfor information on using the
Database Browser.

2. Select and copy tHeisplay Format-ormat object you created $rection 2.5
3. Associate the Format object with the Test object.
To associate a Format object with a Test object
1. Display the Test object’'s Relations view. You can do this in one of two ways:
 Click on theRel button on the Formatbject Tool Bar.
* Execute

View->Change View->Relations
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The Relations viewHigure 2-23 appears.

Tent-cDiwgloy Teak | 507 -Fle|wlisnn |=]=
.|".|'.I'|T|Ilt Sidected Edit Wiew Teols ¥Wilisdoes Helgp
S o M|/ S o |nefu £l
Pagh: Displey Test Hierarchy: 1502

Format: | 1D |Hurut |

M=

[

Rel o B e ——— |-|'.H- e j
ot

Figure 2-23. Test Object Relations View
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2. Execute

Tools->Database Browser

The Database BrowseFigure 2-23 appears. By default, the first time you open the
Database Browser during an AETG session, the Browser displays the Format objects
defined in the AETG database.

=] DatabuseErdwier =1z
-'.-"-'lE,mﬂs:r Selected Edit ‘iew Windows Help

a|m/me)

Databass Object! Format . Size: B
ir | Hame | Wersion | Type | Cmer
S Plairs Sereen 1 AayncRerien | ki
02 manl i ather mirathi
b T i ather mirathl
11 | Format One 1 GulSoreen mim
1502  MewContaat 1 fzynaSoreen | ksh
1501 | KSE Test 1 AsynaSoreen ksh

Eanking Iransaatien 1 ather k5

Figure 2-24. AETG Database Browser
3. Select thdisplay Formatentry, and execute
Edit->Copy
NOTE — You can also select and copy th&splay
FormatFormat object from on the AETG Desktop.
4. Close the Database Browser by executing
Browser->Close

NOTE — SeeSection 5for detailed information on the
Database Browser.
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the top of the view), and execute

5. Onthe unlocke®isplay TesiTest object Relations view, click in tRermat box (at
Edit->Paste

A listing for theDisplay Formatobject appears in thermat box. (Seé-igure 2-25)

Temkd Tesk | GIF-Fle|atisns ==
|".|'I'|TE!1: Sedeehedl Edit View Teols Wiindoes Hilg
Sy mEARe Ml &
Path: Display Test Hierarchey: 502

Format: |10 | Hame |
L1504 | Dénplary Format

| ] -

Relations: [0 Mamg | I'.I'.I-E‘llld. I:Il;l-uriEIii:m

-

Figure 2-25. Associating a Format Object with a Test Object

6. Proceed t&ection 2.%0 create a Relation object for tbésplay TesiTest object.
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2.9 Create a Relation Object
Relation objects let you collect requirements data to establish how fields and values on the
format relate to one and another.
To create a Relation object
1. On the unlocke®isplay TesiTest object’'s Relation view, execute
Test->New->Relation

A new unlocked Relation objectigure 2-26§ appears.

= Felation ¢ Batithed Relatinme—-Propertics |=]=
.ﬂ-‘.-'lﬂt-:l.l:ll:-n Spleated Edit YView [ools Wendows Help

of | 5] Bl @ [ ] e e o] a

Format Hame version: Display Format. |

Test |10 | Hicrarciy & Path | Hame
WISPLAYE ['y502 | Disphay Test Hierarchy Displuy Tem
o | I

L 1— Interaation Degree: | 2 f _'.J

Descrigtion: | i

By Date Timu
Croaad
Rendnd:

Default Wiew: Properties

Figure 2-26. New Relation Object Properties View
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2. Enter, at the minimum, a name for the Relation object ilN#nee text area, for

example Display Rel Figure 2-27shows an edited Properties view, including a
description for the Relation object.

= Relsfor-iUstited-Relation—:-Pauperies
A% | Helation Selected Edit View Tools ‘Wédmdows

= T 5
et
of | B i o & [l o 7| o ] A

Format Hame Version: |'.||I|:;|I!;l Format.1

Test |0 | Hierarchy & Path | Hame
MISFLAYE 1502 | Display Test Hierarchy Diisgeliny Tust
=]

-~

Hamsi: | Display Ael interagten Degree: | 7 i _-.|

Descriglion: | This Felation objeet establishes the eriterio used te |+
(iest the permutations of the Dispday Format displaoy
[elamints.

By Date Time
Criatid
Renvigsgel;

Default Wiew: Properties

Figure 2-27. Edited Relation Object Properties View

NOTE — For now you will accept the default Interaction
Degree value. You will change this value in

Section 2.11
3. Execute

Relation->Save

4. Proceed t&ection 2.1Go generate the Test Case Matrix for this generation.

NOTE — SeeSection 10for detailed information on
Relation objects.

2-25



AETG System Users Guide BR 007-252-007
A Quick Tour of the AETG System Issue 1, October 1997
Release 1.0

2.10 Generate a Test Matrix
Now that you have created a Relation, you can generate the Test Case Matrix, which is the
list of the generated set of efficient test cases.

To generate the Test Case Matrix
1. Display theDisplay TesfTest objet.
NOTE — If you can not see this object, you can display
it using thewindows menu. (Se&ection 3.1.3.))

2. Display the Test object’s Matrix view. You can do this in one of two ways:

 Click on theMat button on the Test object Tool Bar.
* Execute

View->Change View->Matrix

The Matrix view {igure 2-28 appears.

=l Tent clsplay Test:] G Matrix [=]=
.I'_h'l Test Seleeted Edit Wiew Teols ¥ilisdores Hilg
=] T:Fh|ﬁa]:flﬁ i;_nnlmln|4 E!T
Path: Display Test Hierarchy: 502
Mdgtris Inhe
Giimeration Date; Walld Test Cases:
Hame: vl Test Cases:
Wl Top Dhalie ) Toal:
b
TE Hame | Type

Figure 2-28. Test Object Matrix View
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3. Execute

Test->Matrix->Generate

The AETG System generates the Test Case Matrix based on the criteria you set on the
Relation object. (Segigure 2-29)

| Tent clsplay Test:] G Matrix [=]=
|".|'.I'|lel‘t Sedeehedl Edit View Teols Wiindoes Hilg
S ¥ W[ S Wl £l
Path: Display Test Hierarchy: 502
Rdatrbe nfi
Gineration Date; BRZNOT 15:23:04 ‘Walld Test Cases; §
Hame: <umiitieds lirvalid Test Cases-0i
U Tor Dhakie! Wis Tatal: 8
Pt
TC Hame | Type | Shage | Codor | Antribute |
el | Clrale | Blse | Maniblinking|-.
el W Siisarg il ow Elinking
WF W Sqsarn il Henblihiieg
W1 W Circle Rl Relinking
Wl W Circle Witllaw | Henblinking
W-5 W T Bl [Elinking

=g

| =

Tesd Malrts completed - H lesl cases genersied.
E 1L

Figure 2-29. Generated Test Case Matrix
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4. To save the Test Case Matrix, execute
Test->Matrix->Save

The Save Matrix DialogHigure 2-3() appears.

=|  AETGMauixChowser |
Saved 3
Idatrices: J
i
Bave To: |
oF | Ay Candl |

Figure 2-30. Save Matrix Dialog

5. Enter a name for the Test Case Matrix, for exanist Case lin theSave To text
area Figure 2-3), and click oroK.

=| AETGMewixChosses |

Sorwed 4
atrises: J

Toavp To |TE!.I Case 1

o | Apply Cacal |

Figure 2-31. Entering a Name for the Test Case Matrix
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6. The Save Matrix Dialog disappsaand the name is entered on the Matrix view. (See
Figure 2-32)

= Tent laplay Teat:] G- Mabix (=]
|".|'-'|TE!1: Sedeehedl Edit View Teols Wiindoes Hilg
Sy mEme M~ &
Path: Display Test Hierarchy: 502
Matrts Infis
Gimeration Dete; BRZNOT 15:23:04 ‘Walld Test Cases; §
Hame: Test Case 1 firrvbid Test Cases-0
U T Diaki; Vs Total;
Pt
TC Hame | Type | Shage | Codor | Antribute |
Vo0 " | Cirale | Bl | Masiblimking|-
Vel W Sqisare Yellow Elinking
W7 L Siusary il Hnbliiking
V-3 W Cirele Fied Bfinking
Wl W Cirele illow Henblinking
-5 W T Bl Elinking

Figure 2-32. Saved Matrix View

7. Proceed t&ection 2.110 change the interaction degree.

NOTE — SeeSection 9.3.3or detailed information on
generating Test Case Matrices.
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2.11 Change the Interaction Degree

The Interaction Degree, which you set on the Relation object Properties-iigue( 2-26,
determines how the fields in the generated test cases interact with each other. The
interaction degree is restricted to an integer fotmN, whereN is the number of Fields
in the Relation.

For example, a degree ®fguarantees that, for any two fields, @dissible value
combinations are covered in the set of generated test cases.
NOTE — SeeSection 10.2.for more information on the

Interaction Degree.

For this Quick Tour, you will change the Interaction Degre® the maximum value for
this Relation. This creates glbssible permutatiorfer the defined Fields and Values.

To change the Interaction Degree

1. Display theDisplay RelRelation object’s Properties view, and unlock the object. (See
Figure 2-33)

b | Halstiyn-£Display Rel:1 hN8-Properdise
#| Retation Sewcted Edit View Tools Winduws
of | | O | = el g o v

Format Hame Version: Display Format. |

jest 10__| Hisrarch § Path o
Display Test Hierarciny:

MDISPLAY: | 15002 |.1T:p_+q1eu
| 1

Mume: Digplay Ael Intisrgetion Dagra: X i

L]
=
L]

T

g

Deseription: | This Relation object establishes the criteria used o |2
tirsd M peirmikatiors of the Diaplay Format display
elements.

Ry Date Timnie
Cremed:  ksb R 1.587 14237 48
Redised: | ksb Lilrrlir) 140038

Defani View: Fropemies

Figure 2-33. Unlocked Relation Object Properties View
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2. Select the current Interaction Degree vaRjén thelnteraction Degree text area.
(SeeFigure 2-34)

ﬁTlE,rtﬂ.ﬂ-nn Seleated Edit Wiew Toeols Windows

Aristian-£Meglay Reli G04-Fmpetice [=]=

Heip

o | 0| ) © Wl o e | ]

Farmal Hame Varsion: Display Format, |

Test |10 _| Higraceho AFa
(DISPLAY):

g

1502 | Display Test Hierarckny:
|

Display Test
]

-

Hame: |Disglay Rl

Inberastion Degnee: D

Figure 2-34. Selecting an Interaction Degree to Change It

3. Type3. (Seerigure 2-35)

Flcltn-<Disphay REL] 504> Propedics [=]=
| Betation Selected Edit Yiew Tools ¥indows Help
o [ B8] © ] ] e o] al
Format Hame Version: Display Format, | 1504
Test [ | | Hame
(ISPLAYYE: [502 | Display Test Hierarchy:
|

Display Test
]

4. Execute

Relation->Save

5. Display theDisplay TesfTest object’'s Matrix view.

Interation Degree:

-

Figure 2-35. Specifying a new Interaction Degree
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6. Execute
Test->Matrix->Generate

The AETG System regenerates the Test Case Matrix using the new Interaction
Degree. (Se€igure 2-36)

= Tent laplay Teat:] G- Mabix (=]
|".|'.l'|TEl‘t Sidected Edit Wiew Teols ¥Wilisdoes Hilg
SymEARMed~mel &
Path: Display Test Hierarchy: 502
Bdatris Infe
Gimeration Date; ORZX0T 141040 ‘Walid Test Cases; 17
Hame: <uniitieds limvalid Test Cases-0
Wl Tow Do} Wi Tetal: 12
b
TC Hame | Type | Shage | Codor | Anribute |
PR W | Cirale | Red | Binking |
Wl W Cireli Al iz hilinking
W-2 W Circlie Blusir Elinking
w-3 W Cirele Blisi Maaihliikiieg
W W Circle Wiellow Elinking
-5 W Circle Wl Hanhlinking
Wl . Fuare Red Blinking
W=7 W Snuare Fed | Haenblinking| |
-l W | Square Hlur | Blinking
w-a W | Square Bl | Henblinking| |,
~ | -
Tesd balris completed - 138 1esl coxes genprated E

Figure 2-36. Generated Test Case Matrix for new Interaction Degree

7. Execute

Test->Matrix->Save

2-32



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 A Quick Tour of the AETG System
Release 1.0

8. Enter a new test case name in the Save Matrix Ditfdogxample,Test Case 2
(Figure 2-3) and click onOK.

| AETG Matiix Chousen

S
atrises:

Toavp To |Tr::.:| Case A

ox | Apply Carvesl

Figure 2-37. Saving the new Test Case Matrix

9. Proceed t&ection 2.140 create an Exclude.

2.12 Create an Excluded Test Case

So far, you have used the AETG System to create test cases that generate all permutations
for the defined Fields and Values. Often, however, there may be permutations you don'’t
want to include in a Test Case Matrix. Conversely, there are permutations that you want to
ensure are included. Further still, you may want generate test cases containing invalid
values to do error condition testing. The AETG System lets you define such rules.

For this Quick Tour, you will create an Excluded Test Case that omits all Yellow Squares
from the Test Case Matrix.

To create an Excluded Test Case
1. Display theDisplay Rel.Relation object.
2. Display the Relation object Excludes view. You can do this in one of two ways:
 Click on theExc button on the Relation object Tool Bar.
* Execute

View->Change View->Excludes

2-33



AETG System Users Guide
A Quick Tour of the AETG System
Release 1.0

BR 007-252-007
Issue 1, October 1997

The Excludes viewHigure 2-39 appears.

Feclatian-<Diaplay el 15043 Exduides B
| Betation Selected Edit Yiew Tools ¥indows Help
¥ B 9 08 ] ne[nejes ] 0
Farmat Hame Version: Display Format,] 1504
Test [0 | Hame
ISFLAYE: 502 | Displuy Teat iierarchy: Display Tess
| 1

- Extladed Test Cases -

| Hame Cresaripbion

I'_.\j

2 | L-

Haimi: | Deeseription:

i

Wahies: . Shaps

| Colas | airmuce | |
Circle Blue | Blinking
 Square Hed | Morblinking
Veliow ! 7
- | | =

Figure 2-38. Relation Object Excludes View

3. Unlock the Relation object Excludes view.
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4. Execute
Relation->New->Exclude

TheName text area is populated wittnew-test-case>as is theName field in the
Excluded Test Cases list. (See~igure 2-39)

b= | Feclation-<Diapley Ael. 15043 Exdules |=q=
.ﬂl‘“'lﬂtlﬂ.ﬂll:-n Selected Edit Wiew [aols ‘Windowes Help

of |5 ] @ o] ] e al
501

Faormat Hame Version: Display Format, | 1

Test [0 | Higrarsiny & Fath | Hame
(ISPLAYYE: [502 | Display Test Hierarchy: Display Test
=4 ]

-

Excluded Test Cases
Hame | [resaripticon

Hame: | IESNTEIEETNS  Deseription: ﬂ
Values: | Shape | Color | attribute |
Circle Blue | Biirking =
Square Hed | Honblinking
YEllom | T
Tpl | 5 ———= . =

Figure 2-39. Creating a new Excluded Test Case
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5. Enter a name for the Excluded Test Case, for exampllawSquaresand,
optionally, a description of the Excluded Test Case. [(Sgere 2-40)

Feelation-<Diaplay Ael. 15043 Exdules |=]=
.ﬂl”lﬂt'l‘ﬂ.ﬂtll‘l Sedected Edit Wiew [ools Win-does Help
] 3] e ] B
Formal Hame Versiomn: Display Format,] 1504

Test [0 | | Hame
(ISPLAYYE: [502 | Display Test Hierarchy: Display Test
=4 ]

Excluded Test Cases

il seirlbend agiianis

Hame: | YellowSqusares Desaription: | This eo:ludes all pellow |5

Sijlaares,

wakies: | Shaps | Colas | Adtriuce |
Circle Elue | Biinking %
Square  Hed | Honblinking

Yellom
Tpl | I'-l — =

=

Figure 2-40. Specifying an Excluded Test Case Name

NOTE — You cannot include embedded spaces in an
Excluded Test Case name.
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6. Select the values for the Excluded Test Case iNdhes list (at the bottom of the
view).

A. Click on theSquareentry in theShape column.

B. Hold down theControl key, and click on th&¥ellow entry in theColor column.
The Excludes view will be similar to the oneFmgure 2-41

Feelation-<Diaplay Ael. 15043 Exdules

|=]=
.ﬂl”lﬂtlﬂ.ﬂtll‘l Selected Edit Wew [eols Wilndoes Hedp
o | B R B © 3] e ) a
Format HameVersiomn: Display Format. ] 1504
Test [0 | Higrarsiny & Fath | Hame
(ISPLAYYE: [502 | Display Test Hierarchy: Display Test
=l 1

-

Excluded Test Cases

Hame: | YellowSqusares

Deeseription: | Thin ealudes all yellow

-]
SijLares, |
wakies: | Shaps | Colar | Aftribute |
| Circle Blue | Blinking 0
Pm- hed | tonbinking
|ﬁ ¥
Tpl | I‘-l xrcar— 3 =

Figure 2-41. Selecting Values for an Excluded Test Case
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7. Click on theSet button. This applies the selected values to the Excluded Tsst Ca
The system displays a message that the values have been set for the test case. (See

Figure 2-42)
b= | Feclation-<Diapley Ael. 15043 Exdules |=q=
.ﬂl‘“‘lﬂtlﬂhl:-n Selected Edit Wiew [aols ‘Windowes Help

o | ] © 3] o] e e e ] al
501

Format HameVersiom: Display Format. |

Test 10 | Higrarehy & Pach | et
ISFLAY]. e

il seirlbend agiianis

Hame: | YellowSqusares Desaription: | This eo:ludes all pellow |5
SijLares, |
Vahies: | Shaps | Colos | Attribube |
| Cirgle Blue Hinkmg 15
Hed Hanblinking
| i vellow | ¥,
Sul | | — - =

Valies lor LESE cxse TYillowESqeares” ael Enn J

Figure 2-42. Setting Values for an Excluded Test Case

8. Execute
Relation->Save

9. Execute
Relation->Close

10. Display theDisplay TesfTest object’'s Matrix view.
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11. Execute
Test->Matrix->Generate

The AETG System regenerates the Test Case Matrix using the Excluded Test Case.
(SeeFigure 2-36)

= | Tent ClEsplay Test: | S0 -Matis [=l=
|".|'.l'|TEl‘t Sidected Edit Wiew Teols ¥Wilisdoes Hilg
SymEARMed~mel &
Path: Display Test Hierarchy: 502
Bdatris Infe
Giimeration Date; ORFROT 151931 ‘Walid Test Cases; 10
Hame: <uniitieds limvalid Test Cases-0
Ul Tiv Dhakie; Was Taqal: 10
b
TC Hame | Type | Shage | Codor | Anribute |
PR W | Cirale | Red | Binking |
Wl W Cireli Alise BElinking
W-2 W Circlie Blusi Mz blinding
¥-3 W Cirele | Wiallow Eilinking
W W Circle Al Masihlinking
-5 W T e [Elinking
Wl . Fuare Red | Hanblinking
W=7 W Snuare Hiwe | Elinking
Wi W | Square Hlue Hanblinking
w-a W Cirale Yellow | Henblinking| -/
~ | -
Tesd balris completed - 11 lesl coxes genprated E

Figure 2-43. Excluded Test Case Test Case Matrix

12. Execute

Test->Matrix->Save
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13. Enter a new test case name in the Save Matrix Ditdogxample,Test Case 3

(Figure 2-3) and click onOK.

=]

S
atrises:

.

Save To: |Tn:.l Case 3

AETE Muirie Chooser

Tesl e 2

Ay (W1

Figure 2-44. Saving the Excluded Test Case Matrix

14. Execute

Test->Close

15. The AETG System displays an alert dialb@(ire 2-4% asking you if you want to
save your changes. Click @x.

=

AE TG WA RRNG

__AFs

! Close:

Hobe thal anvy changes made bo the
Foarmat and Relations indarmation
Bor this Test have already been
swved in the datskwse and will mol
be undong by anlecting "Ha",

Save Objeet Changes?

__Ho | Canced |

Figure 2-45. Save Changes Dialog

NOTE — SeeSection 10.2.4or information on creating
Excluded Test Cases.

2.13 Exiting From the AETG System

If you wish to exit from the AETG System, execute

Aetg->Exit
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2.14 What's Next
This Quick Tour should have given you a general feeling for the AETG System and what
it can do for you.

The remainder of this Users Guide provides detailed information on how to use the AETG
System.Table 2-Zist the sections in this document that contain information on how to use
the AETG System.

Table 2-2. AETG System Users Guide Sections

Section
Number Section Name Description
Section 3 | AETG Basics This section contains basic information on using

the AETG GUL.

Section4 | Using AETG Objects | This section contains information on how to uge
AETG objects

Section 5 | Using the Database |This section contains information on the AETG
Browser Database Browser.

Section 6 | Format Object This section contains information on Format
objects, which describe a testable interface to [an
application or a testing situation.

Section 7 | Field Object This section contains information on Field objects,
which define the data values that are input to an
application.

Section 8 | Compound Object | This section contains information on Compound
objects, which let you collect several Fields and
treat them as one Field.

Section9 | Test Object This section contains information on Test obje(ts,
which define the means by which a requirement is
verified in a softwar@pplication.

This section also contains information on how |to
generate a Test Case Matrix.

Section 10| Relation Object This section contains information on Relation
objects, which let you collect requirements data to
establish how fields and values on the format relate
to one another.
Section 11| Command Line Toolg This section contains information on the AETG
Command Line tools.

Section 12| Input Modeling with th@his section provides tips on how the AETG
AETG System System could be used to model various types pf
applications.
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3. AETG Basics

Although the GUI is easy to use, we will explain the basics of its operation in some detail
here to help you enjoy the power of the AETG System.

This section covers:

* What folders are.

The layout and operation of the system’s major windows and dialog boxes.

Basic actions needed to navigate around the AETG System.

Controls used in the AETG GUI.

How to perform some routine tasks.

3.1 AETG Folders

Folders are provided for your convenience so that you can organize your work. You can
think of folders as drawers in a filing cabinet. For examgl@pose you have a filing
cabinet with three drawers.

» The first drawer contained documents related to Release 1 of a software product.
» The second contained documents related to Release 2 of a software product.
e The third drawer contained documents related to Release 3 of a software product.

In the AETG System, theliing cabinet itself would bthe AETGDesktop. Within the
AETG Desktop there could be other folders that correspodicht@ers in the filing cabinet.

» The first folder could contain objects related to Release 1.
» The second could contain objects related to Release 2.

e The third could contain objects related to Release 3.
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Figure3-1lillustrates this idea.

AETG Desktop

One folder / test hierarchy]

for each Release P
softwar ormat

release test hierarchy]

[format]

[ test hierarchy]

Filing Cabinet

Forms <

related to
arelease.

i

Figure 3-1. What Are Folders?

You can create folders when you need them and delete them when you no longer need them.
Folders can appear in the AETG desktop. You can move objects in and out of them by
copying the object from one folder to another.

The AETG Desktop is the first folder you encounter when you start the AETG System and
serves as the main entry point to the system. (S&ree 3-2) Unlike all other folders, the
AETG Desktop cannot be created or deleted, but you can create and delete other folders
within it.

3.1.1 What is the AETG Desktop?

You can think of the AETG Desktop as you would the top of your desk. It is a work space
where you can collect all the objects and folders you will need for testing.

The top of your desk contains folders and tools, such as pens, a telephone, and a computer,
which help you do your job. The AETG desktop also has folders and tools that help you
create your test cases.

In this chapter we will discuss some of these tool§dntion 4we will discuss more of
them.
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Figure 3-2. AETG Desktop List View

The AETG Desktop we have depicted above shows the List view. We will explain more
about views irSection 3.5

The basic window layout is the same for all folders as it is for the AETG Desktop. The
layout we describe here applies to all other windows.

3.1.2 Title Bar

The top line of the window, called the Title Bar, displays the name of the GUI window. In
our example, the name of the foldBesktop-List , appears here.

NOTE — The AETG System was designed to use the
Motif ™ window manager, but will work with any
X-windows manager. Whalements you see on the Title
bar will depend on which window manager you use.

When using the Motif window manager, the left-hand side ofitteeBar contains the
System Menu , represented by a small bar, which operates the window itself. When you
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click on the bar, the window manager displaysSlgetem Menu that, depending on
window manager, has the following menu selections:

Restore Restores the window to its original size after you have re-sized it. This is not
the maximized size, but the size the window was originally displayed by the
window manger.

Move Lets you move the window using the arrow keys or by dragging it.

Size Lets you re-size the window using the arrow keys or mouse.

Maximize  Increases the window size to the maximum allowed by the window manager.
Minimize Reduces the window to an icon.

Lower Moves the window to the bottom of théndow hierarchy.

Close Closes the window.

On the right-hand side of thétle Bar are two buttons. The smaller one on the left
minimizes the window, i.e., turns it into an icon; the larger one on the right maximizes the
window, i.e., increases the window size to the maximum allowed by the window manager.

3.1.3 Menu Bar

The next line in the window is called tMenu Bar. The menu bar contains all the menus
for the window you currently have open. Many of the activities you will do to perform
operations will begin from the menu bar.

TheAetg, Selected , Edit, View, Tools , Windows , andHelp menus appear on the AETG
Desktop. The name of the first menu on a folder varies with the name oifntth@w So,

for example, the AETG Desktop hastg as the first menu. Thgelected , Edit, View,

Tools , Windows , andHelp menus appear on all windows although the menu selections
available on these menus sometimes vary.

3.1.3.1 AETG Icon

An AETG System iconHigure 3-J appears to the left of the menus.

il

Figure 3-3. AETG Icon

If you click on the AETG icon, the system displays the AETG Banmedaow.
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We describe the AETG Desktop menus and their selections in some detail here. The
following sections of this Users Guide discuss variations in menu selections where
appropriate.

3.1.3.2 Aetg Menu

The menu selections for tietg Menu are

Save Saves the contents of the AETG Desktop, any preferences you
set with the AETG Preferences view and any queries defined for
the Database Browser.

New Lets you create a new AETG object.

Iconify All Windows Reduces all open windows to icons.

Exit Closes the main folder, any open falsleandexits to the UNIX
prompt.

3.1.3.2.1 What Happens When You Save a Folder

To save a folder, click on th&ave option of the first menu that appears on the left-hand
side of the Menu bar. The system saves the contents of the desktop or folder.

NOTE — Remember, the AETG Desktop is a specialized
folder.

The system saves the organization of folders and any preferences you selected to the
xmyMYNAHTrdile. This file is located in your home directory and is read by the system
when you start-up the system. Every time gawme, the system copies tbemyMYNAHrc
file to a.xmyMYNAHTrc.bakile and then saves to themyMYNAHTrdile.

While you are running the AETG System, it saves the contents of folders, the desktop, and
the preferences you selected every 60 seconds to a file named
XmyMYNAH.rc<hostname>.<process.id¥he system uses this file as a backup in the
unlikely event of a system crash. This ensures that you will never lose more than sixty
seconds of desktop work. This file is removed during normal exits, but if there is a crash,
the system will ask you if you want to open it as the crash recovery file.
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3.1.3.3 Selected Menu
TheSelected Menu offers you actions that apply only to AETG objects you have selected
and to create new objects. Selections include:

New Displays a cascade menu that lets you create new AETG objects on the
AETG Desktop or in a folder. (Sée=ction 4for a detailed explanation of
AETG objects.)

Open Lets you open a selected object.
Delete Deletes a selected object from the desktop and database.

Expand Fully  Displays the complete contents (objects) of folder or hierarchies, i.e.,
displays all parent and child objects contained in the desktop or a folder.

3.1.34 Edit Menu

TheEdit menu provides you with a number of tittj featues. Selections include:

Undo Cancels the previous change to a text field.

Cut Removes the selected item from the display and temporarily places it on a
clipboard.

Copy Places a copy of a selected item on a clipboard.

Paste Retrieves an item from the clipboard and places it in the client area of
folder.

Clear Removes the selected item from the display, but does not place it on the
clipboard.

Select All Places all visible items in a selected state.

Deselect All Deselects all visible items.

3.1.35 View Menu
TheView Menu lets you change to another view or refresh the AETG Desktop display.
Selections are:

Change View Displays a cascade menu that lets you change the view for the currently
opened object.

Refresh For the Desktop, refreshes the current view by removing objects from the
display that are no longer in the database; for Folders and objects, gets the
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latest copy of object from the database; and foDttabase Browser ,
reissues any defined or default queries.
3.1.3.6 Tools Menu
TheTools menu lets you display tHeatabase Browser , which lets you search for
objects in the AETG database. You can open or run objects directly from the Database
Browser or copy them to a folder. Seection 4for information on the Database Browser.
3.1.3.7 Windows Menu
TheWwindows menu helps you to manage the windows associated with the AETG System.
Selections include all the currently opened windows even if they are iconified. Selecting
one of the window names from the list brings that window to the top of your display.

3.1.3.8 Help Menu

The final menu on the AETG Desktop window is Hep menu. The selections are:

Contents Displays a list of help topics. (Available in futuredeases.)

Procedures Displays a list of hypertext links to help on tasks and disui
(Available in future releases.)

Keyboard Lists key accelerators and their uses.

On Help Displays help messages on the help system. (Available in future
releases.)

On Icons Displays the icons thapaear on the AETG Desktop, folders and

Tool Bar, and gives a brief description of each.

On Version Displays product information.

3.14 Tool Bar

As you can see iRigure 3-2Z icons appear directly below the Menu Bar in what we call the
Tool Bar . These icons represent often used functions that correspond to menu selections.
We placed them here for your convenience. The features available on the Tool Bar change
depending on the windowable 3-1lists the tools available with the AETG Desktop along
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with a brief description of each tool. We will describe other tools when we discuss the
object view on which they appear.

Table 3-1. Tool Bar Icons and Functions

editing.

Icon Function What It Does
print Causes the system to display the Print dialog with
Q which you can print the contents of objects or folders.
cut Removes the selected item and temporarily places it on
paﬂ a clipboard. This does not remove items from the
— database.
copy Places a copy of a selected item on the clipboard
paste Retrieves an item from the clipboard and places itjin the
|13| client area of folder.
delete Deletes a selected item from the database and clears it
'@‘ from the display.
i
Save Saves the contents of the AETG Desktop, any
q preferences you set with the AETG Preferences view
and any queries defined for the Database Browsel.
change |Changes the currentview to the view represented by the
Lat view icon, e.gLst changes view to the List view. Icons vary
with the views available for an item.
clear Removes the selected item from the desktop, but|does
4’/ not place it on the clipboard.
refresh Refreshes the AETG Desktop view.
]
lock Unlocks the AETG item, making it ready for input pr
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You use the Tool Bar by clicking on the icon that corresponds to the function you want.
Depending on the icon you selected, the AETG System will either perform the &cgign (
Cut, Copy, Paste, Change View ) or display a dialog with which to perform the function
(e.g.,Print).

3.15 Client Area

The central part of the AETG Desktop window between the Toolbar and Status box is

called the client area. The client area is where you will perform most of the operations

needed for test and script development and execution. The AETG System displays the
contents of GUI objects in this area.

3.1.6 Status Bar

The bottom line of the AETG Desktop is the Status Bar that displays text messages on the
left-hand side. Two areas appear on the right-hand side of the Status Bar: one on objects
that displays the cursor location and the other that displays the current mode the AETG
System is in. Mode refers to whether the object view is locked and inaccessiblitifgr ed

or unlocked and ready for editing. When you unlock an object, the word EDIT will appear
in the Status Bar.

3.1.7 Scroll Bars

The AETG Desktop has two scrollisa One appeaaong the right-hand side of the
window while the other appears directly below the client area. The scroll bar on the right
moves the client area display up or down. Thelsbar at the bottom moves the client area
display left or right.

These scroll bars are particularly useful since the ABHBBlay can have a virtual display
area, i.e., text is present that appears beyondsdise display. Scroll bars let yaee this
text.
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Figure 3-4shows how to use scroll bars.
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Figure 3-4. Using Scroll Bars
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3.2 AETG Dialogs

The AETG System uses a number of Dialogs (often called dialog boxes) to help you
perform test and task-automation activities. In gehelialogs are windows accessed from
a folder that presents you with a number of controls with which to perform actions
supporting the function of the folder from which they were called.

The AETG System uses three basic types of dialogs:

» Dialogs that let you complete or control operations you initiated from a folder or object
view.

» Dialogs that let you set the properties of objects.
» Dialogs that present system information to you such as error messages.

We will describe other dialogs where appropriate in the sections that follow.

3.3  Navigating Around the AETG GUI

The AETG GUI provides you with a number of controls to help you move through windows
and dialog boxes and perform operations. Generally, the way you get from one folder to
another is by making a menu selection or activating an icon.

3.3.1 Using the Mouse

Table 3-2defines several terms used when describing mouse actions throughout this
manual. All of these terms refer to action you take witHe¢fienouse button You do not
use theright mouse buttonfor any AETG specific operations.

Table 3-2. Mouse Actions

Action Description
Click Press and release the mouse button.
Double Click Press and release the mouse button twice.
Drag Place the pointer on an object @mu. Press the

mouse button and hold it while moving the
pointer. Release the mouse button when th
action you want is accomplished.

D
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3.3.2 Using Icons

Icons are graphical representations of objects and folders that appear in the client area. They
also represent tools in the Toolbar. We have already discussed the icons in the tool ribbon
and how to use them. (S8ection 3.1.9 Here we will describe the icons that appear in the
client area. Folders and other objects can be reduced to an icon when you are not using
them.Figure 3-5shows a folder reduced to an icon.

w» S AFTG [1ETe uhiig F oldar =
m.ﬁ.[-IE Test Higrarehy 24 te il Teatbier

Figure 3-5. AETG Icon

An arrow appears next to an icon if the icon represents a folder that contains other objects.
For example, if we had a folder that contained a number of other objects, an arrow would
appear next to it as we have illustrated. The peak of the swows at the object when the
object has not been expanded. We will explain how to use the arrow when we describe the
List view (Section 3.§.

To transform an open object into an icon:
1. Click on the first menu
2. Click on theClose menu selection.

To activate a window that has been iconified, double click on the icon that represents the
object.

3.3.3 Making Menu Selections

You can select an item from a menu by clicking on the menu and then clicking on the menu
selection you want. You can also use Mnemonic keys.

3.34 Using Mnemonic Keys

Mnemonic keys are individual keys you can use rather than the mouse to make menu
selections. Letters that correspond to mnemonic keys appear underlined in the menu
selection name. Thedt key combined with a single keystroke can initienu selections.
For example, you can open a selected object by tyhiragndS and then O, e.qg.,S for
Selected menu ard for Open.
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3.35 Using Accelerator Keys

The AETG GUI provides accelerator keys. Accelerator keys are key combinations that you
can use instead of mouse actions to make menu selections and perform other common

actions.Table 3-3list the canmon acelerator keys for the AETG Desktop.

Table 3-3. Key Accelerators

Keys Function
Ctrl+P Print
Ctrl+X Cut
Ctri+C Copy
Ctrl+V Paste
Ctrl+/ Select all items
Ctrl+\ Deselect all items
Ctrl+F4 Close
Del Delete selected item
F5 Refresh
Esc Deselect a menu.
Tab Moves the cursor focus from o
data entry field to the next.

There are other accelerator keys. Thesdisteal next to the menu selections theyfqen.
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34 AETG GUI Controls

If you are familiar with common GUI controls, you can skip most of this section and go on
to Section 3.4.5

There are a number of common controls you will have to use to accomplish tasks associated
with testing. You may be familiar with many of these, but we describe them here for you
in case you need a quick refresher course on GUIs.

3.4.1 Using Spin Buttons

Spin buttons are GUI control that helps you to make settings. You use spin buttons to set
values when the values are an ordered exclusivéisgt.e 3-6shows some typical spin

buttons.
r &
ncrease
Value
£

Figure 3-6. Spin Buttons

Decrease
Value

il

To set a value with a spin button, perform one of the following:

 Click on the up or down arrows that appear next to the Value display. The up arrow
increases the value in the display area; the down arrow decreases the value.

» Position the pointer in the value display area and type in a value.

3.4.2 Using Toggle Buttons

Toggle buttons are simple on/off buttons. Toggle buttons ppeaa in a group or
individually. Figure 3-7shows a toggle button.

Toggle Button - OFF Toggle Button - ON

Uimlock Dijeets Wien Created W Lnlozk Objects When Created

Figure 3-7. Toggle Buttons

To set a toggle button, click on it to set it on or off. When it is ON the button will be
highlighted.
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3.4.3 Using Radio Buttons
Radio buttons let you select one option from a group of options. They are exclusive

settings; you can only select ofiem a groupFigure 3-8shows a group of radio buttons
with All Code selected.

~ Inleraction Degree —
# Limirefabed
Crads Produict

Figure 3-8. Radio Buttons

3.4.4 Using Pushbuttons
Pushbuttons are GUI controls used to execute actions that affect the entire window. They

generally appear at the bottom of an AETG window or dialog. You activate a pushbutton
by clicking on it.Figure 3-9shows typical pushbuttons arranged at the bottom of a window.

Sl P Mdwds R

i iy il Drdandis Cadecud

Figure 3-9. Pushbuttons
Table 3-4lists the pushbuttons used with the AETG System.

Table 3-4. Pushbuttons and Their Functions (Sheet 1 of 2)

PushButton Function

OK Acknowledges messages from the system and approves
changes to settings. Usually, this button also closes the
window.

Apply Commits the current setting on a window without closing the
window.

Reset Cancels changes made to the window content and returns the
window to the last approved settings.

Stop Stops any ongoing processes.

Continue Continues a process that has been interrupted.

Retry Lets you retry a process interrupted by the operating
environment.

Pause Suspends an ongoing process without terminating it.
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Table 3-4. Pushbuttons and Their Functions (Sheet 2 of 2)

PushButton Function

Resume Continues a process that was paused Paase above.)

Close Closes a window without affecting a process.

Cancel Closes a window without applying any changes to a window’s
content that have not been applied (8pply above.)

Yes Indicates a positive response todmhation contained in a
message.

No Indicates a negative response to information contained jn a
message.

Defaults Use default values.

Help Displays contextual help informatidar a window.

3.4.5 Using Ruler Column Headings

In many AETG views and dialogs we use what are called Ruler Column Headings.
Figure 3-10shows a window from thBatabase Browser(SeeSection 4 in which all the
column headings are rulers. If you position the pointer on a column edge and drag it, you
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can make the column wider or narrower. This will be useful when the infornuisiolayed
in the column exceeds the default column size.

—{_ Dt il s =B vt o -
4| Browser Selected Edit Wiew Tools Windows Drag column
o hEe edge to enlarge
1% | column.
Database Djeed: Format : :

o — = b

2 format1jk i | other kiehr =

o siiobesh i TS ereen rahrab

1 | Main Soreen 1 | tyymeSareen ksh Double

i cliobech 1 | ) Sareen rabrah click here
e e 0 o1
¥ | mary 1 | other mitm Pased 9,”
M| 1ZIASETEO0 T30 1 | ather i owner.
7 AsyTee Seremmn 1 ASYMESEreEn mim

M GLN Serign 1 GUES EFREn il

2 Message | Message mim

i 1 0 Soneen 1 T Fermm mim

a1 Corfiguration | Canfiguratien mim

12 Delwult ather 1 alfer mim

M| didddddddd i | mther mim

a5 Demo Main Soreem | 1 & Gareen rachel

£ 1 AR DSareen

1

Figure 3-10. Database Browser Displaying Format Objects

If you double click on a column heading in the ruler, the system will sort objects based on
the attributes in that column. For example, if you wanted to arrange objects based on the
owner of the object, you would double click on ener column heading-igure 3-10

shows Script objects sorted in alphabetical order based on the “Owners” name.
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35 What Are Views?

The AETG System uses what we call views. Views appear as a windows on your terminal
screen when you open an AETG object. Views organize information about objects. Each
view displays a certain type of information about an object.

Objects can have up to six different views. You can think of views as pages of information
about an object or as screens in a traditional character based application. Views also let you
enter information about objects and associate objects with other objects.

The AETG Desktop we displayedfigure 3-2uses a List view to represent objects as line
items with icons and text descriptions. This is one of three AETG Desktop views. The other
two are Preferences and Default View views.
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3.6 List View

List Views are very important in the sense that List views are where you begin with the
AETG System and they are views to which you will return often. List views show you all
the objects available in a foldétigure 3-11shows a list view for the AETG desktop.

= [ skinp-List i fm
V) data Sebected ERt View Inolhs Yibwedows Help
o B () il ] e oo 8
- u;n{T:':_ sa0aT Fadiler 4
! [ | AETG Test Hierarciny 1241 ER0AT lestHier
[ | Msin Serwen. | 4 5047 Fonmat

Figure 3-11. AETG Desktop - List View

The List view illustrated if-igure 3-11shows only the first level of objects in your object
tree. But an object can be expanded to show all the child obj&his W, which we will
explain in the next subsection.

3.6.1 Expanding Items in a List View

To expand an object’s listing, click ¢ime arrow next to the object’s iconic representation.
For example, if you clicked on the arrow for icobd#ledAETG in Figure 3-1] the view
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would expand as shown ifigure 3-12 Note that the arrow next to the icon points down to
indicate that this is an expanded display of the object.

I—'l Testfier-cOemo Ralodes Testsc ¥ TR -
A Heowwrche  Soioched BN Sew Tosks edows

o A TR |6 m &

e=
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M

- 1l oo FST P (OCEIAE 154 28 .
k E|"'°"' 2F61 Tesd  10AKSE 1dIE0S
E EI_]|"'°'" A Tesd (iNEISE 1 REER
k ml.-.-.-., I9A Tead  (WEIPE | SolsET

¥

Figure 3-12. List View Expanded

Items that appear on the AETG Desktop may have several levels of items below them in a
hierarchical relationship. When you click on the arrow next to a list item’s icon, as we did
above, the system shows only the first level of the hierarchy.

To see all the levels in a selected item’s hierarchy, execute

Selected->Expand Fully

The system will display all the levels of a hierarchy, as shoviiginre 3-13
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Figure 3-13.

List View Expanded Fully
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3.7  Using the Preferences View

The AETG Desktop Preferences viewdure 3-14 lets you set items that affect all objects
and processing done during the session.

=| Deeknp-Prefenenoss ixf=
7| paty Sebected Edit Yiew Tools Yiimdows Help

r Hﬂmm (= |ER L -]

L-]

Printer: [lor Fomi: Selest
Datakaia Max Size: [ 100 f _'|
Bdice Tiesh Cases: | 500 f A ! Unitock Objeats When Created

Figure 3-14. AETG Desktop Preferences View

The Default Settings are:

Printer Sets the AETG System printer. This selection will appear
automatically on all print dialogs.
Font Sets the font size for system displays.
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Database Max Size  Specifies the number of objects displayed in a Database
Browser view withmitial queries. Foexample, if you specified
50 objects here and the system found 100, the system would
prompt you to choose either the number you select here (50) or
the number found (100). S&ection 4for information about
the Database Browser.

Max Test Cases Specifies the number of test cases that the system will
automatically load into a Test object Matrix view. See
Section 9.3.3.6

Unlock Objects When Lets you set whether or not newly created objects will
Created automatically be unlocked by the system when opened for the
first time.

3.7.1 Saving Default Settings

You can change default values. As an example, let's go through the detindisset if we
were setting them.

1. Position the pointer in tHerinter data entry area and type in a printer name, e.g.,
printerl .

2. To learn how to select a font, séection 3.7.2

3. Position the pointer in tHeatabase Max Sizealata entry area and type in a number,
e.g.,250.

4. Position the pointer in thdax Test Caseglata entry area and type in a number, e.g.,
600.

5. CheckUnlock Objects When Createdif you want the system to automatically open
newly created objects.
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Figure 3-15shows an edited Preferences view.

= Deskiap-Feelerentes
.ﬂ-'-'lﬁ,!‘tg Selecied Edit Wiew Tools Windows

o B|E[fR Bl Sua|m

s

Prisitnr: | priedar] . Fent: Select... |
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bdax Test Casies: [ﬂm i’ 4 | W Linlosk Objects When Created

Figure 3-15. Edited AETG Desktop Preferences View

If you save the Preferences view, the settings will become the default settings for all
subsequent AETG sessions until you change them again. If you don’t save these settings,
they will remain in force for the current session and then revert to the last saved default
settings for the next session.

To save these preferences, execute

AETG->Save
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3.7.2 Selecting The Default Fonts

To change the default font:

1. Click on theFont pushbutton that appears in the cliarga of the Preferences view.

The Font Chooser dialog iigure 3-16will appear. The top panel of the dialog shows
the alphanumeric characters for the current font.

=| Fenl Chousei a0

ABCDE FGHI L MAROPRRSTUVWRY F
abcaelgh | jkbmmopars vy

1 22456789
Pty ! g e H S
BoivESCa S0 DA | | sa 3 [v4

g
nicida * |0 | sans woie itaic i ]
(e oiees [ —— ]

kbl E0SAa9 |
| nrwistvmasritar Sl 0

o | ooty | goeel_|

Figure 3-16. Font Chooser Dialog

2. Choose a forftamily by clicking on the one you want, e.gucida .
Notice that the system changes the font display in top panel.
3. Choose &ace by clicking on the one you wantge.sans bold .

4. Choose &ize by clicking on the one you want, e.g4.

NOTE — Don't setSizeto anything ovef4.
5. Click Apply or OK to change the fonts.

Figure 3-17shows the new font on the Preferences view.
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Like the other default preferences, if you change the default font it will remain irufatice
you change it again with the Font Chooser dialog.

= DeedopPraferences ==

A Aeig Gelected Ecbf ey Took Wndows Help

% 8 e o O]

L-]

Frimbar |I|1|r Fomk, Sebesl

Catmbars Max Sigs: | 100 f -_|

Plmx Tept Cames :El:l:l LY I Unleck O pcss Whan Cregied

Figure 3-17. Preferences View with Font Change

3.8 Changing an AETG View

You can change your view during a session usingi#e menu or by clicking on the Icon
in the Tool Bar that corresponds to the view you want. Changing views will be a very
common activity as you summon different views to complete test and scripting related
tasks.

To change a view perform either of the foliogy:

e Click on the icon in the Tool Bar that corresponds to the view you want, e.g.R«dlick
to change to the Preferences view on the AETG Desktop.
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* Execute
View->Change View

and select the view you want from tieange View drop-down list.

3.9 Creating Folders

As we said earlier, you can create folders and use them to organize your work. We want to
create a folder where we will place all the items needed to document, develop, and analyze
tests for an application. We will name this fold&TG Demo .

You create folders from the AETG Desktop. To hisit
1. Execute
Edit->Deselect All
to make sure nothing is selected.
2. Execute
AETG->New->Folder
The system will display a dialog requesting a name for the new félaerré 3-18)

=] BETG Fequestag Infomaties

Fodsler Mume
AFTG Dimn

ox | _Caneid

Figure 3-18. Requesting Information Dialog

3. Enter a name in theolder Name field, e.g., AETG Demo.
4. ClickOK.
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The AETG System will display the icon for the new folder. (Sieeire 3-19) The system
will display the folder under the new name you gave it. Note that since this is a folder, an
arrow appears next to it even though there is nothing in the folder yet.

=] Desking-LEst ==
.-'.-"_&l!g Gelectesd Edit Wiew Tools Windows Help
o B ()| d| e o B

¥F O AETG Demo (L Folder

[} EF&IE Late e Faldar

Figure 3-19. New Folder Icon

You can open this folder by double clicking on its icon in the List view. You can create
objects from ithin it, or copy objects into it using tixatabase BrowserWe explain how
to use the Database BrowselSiaction 4

NOTE — Test objects do not appear in ordinary folders
butin special folders called hierarchies. Seetion 9or
information on Test Hierarchies.

3.9.1 Saving Folders

To save a folder, execute

Folder->Save

3.9.2 Deleting Folders

You can delete a folder the same way you delete any other object, which will be explained
Section 4 However, you must remember to remove all objects from a folder before you can
delete it.

3.9.3 Changing a Folder's Name
After you have created a folder you can change its name using the Folder Properties view.
To access this view, perform one of the following:
* Execute
View->Change View->Properties

e Click on thePro icon.

3-28



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 AETG Basics
Release 1.0

The system will change the view to the one showridnire 3-20

= TaldnrtAE 1G Demo> Progerties ==
##/| Eobder Soloctud Edn View Tooks Windows Hly
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Figure 3-20. Folder Properties View

We will explain an object’s Properties view in detail when we discuss the object in the
sections that follow. Here we will explain how to change the name of the folder.

To change the name of a folder:
1. Erase the old name.
2. Type in a new name.
3. Execute
Folder->Save

to save the folder under the new name.
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3.10 Printing

The AETG System provides you with a print feature for most objects. You send
information to the default printer, specify another printer, or print to a file.

You access the Print feature from the first menu that appears in the Menu bar. For example,
for Format objectthis is theFormat menu. When you do this, the system will display the
dialog shown ir-igure 3-21

=] AETEG Prim
W Printer|1pr
| Print b File:
) (o] 4 ] E;nc:l_

Figure 3-21. Print Dialog

The printer specified as your default printer Preferences view appearsiintae data
display area. You can simply cliek at this point and the system will print the contents
of the current object according to the default settings.

You can choose to change any of the settings by:
1. Positioning the pointer in thrinter data entry area and typing in another printer
name.
NOTE — Print Range, Copies andCollate Copieswill

be available in future releases.

2. If you want to print the contents of the object to a file, click orPthe to File toggle
button and type the output destination in File data entry area.

3. After you make your selections, clicK to print.
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Figure 3-22shows an example of a Print Dialog box where we have entered a printer
destinatiorand the name of a file that will contain the printout.

=| AETE Print
W Printer:|lpr <P delault_prinier

= Prinl to rlln;-;inl:-df:.l'usl'.'rl.‘l.lbu'.ﬁ.[-'lﬁl

) (o] 4 ] E;nc:l_

Figure 3-22. Example Print Dialog Box
If you print the output to a file, you must specify, at a minimum, the path to the directory
where you want to store the output file, elgdfs/users/ksb/AETG

If you specify a path, the AETG System saves the file using a system generated filename
of the form<Objectname>.nwhere

e <Objectname>is a type of AETG object that lets you generate output
* nis a system generated number.

For example, if you want to print a Format object and you specify a path only, e.g.,
/bdfs/users/ksb/AET,Ghen the AETG System will generate an output file with a full path
and filename such dbdfs/users/ksb/AETG/Format.3120

You can override the system generated filename by specifying your own filename, e.g.,
/bdfs/users/ksb/AETG/Format_output

When you print informatio